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उपयोगकर्ता पुस्तिका के विषय मे

इस उपयोगकर्ता पुस्तिका मे रोज़मरा के कार्यो के लिए मार्गदर्शन दिया गया है, जो किसी व्यवस्थापक (कंप्यूटर प्रयोगशाला में प्रभारी, शिक्षक) के लिये आवश्यक हो सकता है। यहाँ यह मान लिया गया है कि व्यवस्थापक को लिनक्स डिस्ट्रिब्यूशन मे कार्य करने का मौलिक ज्ञान पहले से ही है क्योंकि इस सर्वर को प्रयोग करने का उद्देश्य विध्यालयों मे लिनक्स विषय पढ़ाने का है। सर्वर के उपयोग को लेकर सम्पूर्ण मार्गदर्शन इस दस्तावेज़ के दायरे से बाहर है।

हमने "उपयोग मे सरलता" को ध्यान मे रखते हुए माय स्कूल सर्वर बनाया है जिससे काफी सारे कार्य (सभी तो नही) पूरे किए जा सकते है आरटीएफ़एम [https://en.wikipedia.org/wiki/RTFM] किए बिना, हालांकि यह समजना आवश्यक है कि यह इतने सारे कार्योकि पूर्ति करने वाला यह डिवाइस बहुत जटिल प्रौद्योगिकियों के इस्तेमाल से बनाया गया है, व्यवस्थापक के लिए यह जरूरी है कि वो कम से कम दिये गए निर्देशों का पालन करे और एप्लिकेशन द्वारा दी गयी नियमावली को अच्छी तरह से पढ़कर उसका पालन करे और जो विवरण उपलब्ध नही है उसके विषय मे ऑनलाइन जानकारी हासिल करे।


महत्वपूर्ण सूचना

रेशेशे टेक ने यह सूचना प्रदान कि है प्रकाशन के समय इसे सटीक और विश्वसनीय मानते हुए, परंतु इसे किसी भी प्रकार कि वोरंटी के बिना प्रस्तुत किया गया है, चाहे वो व्यक्त हो अथवा निहित। किसी भी वस्तु के उपयोग कि सम्पूर्ण जवाबदारी उपयोगकर्ता कि रहेगी। रेशेशे टेक इस दस्तावेज़ में प्राप्त किसी भी गलती की ज़िम्मेदारी नही लेता है। रेशेशे टेक अपने पास यह अधिकार सुरक्षित रखता है के वो बिना किसी सूचना के अपने उत्पादो के डिजाइन या विनिर्देश मे परिवर्तन कर सकता है। यह जानकारी बिना सूचना के बदली जा सकती है।




प्रतिबंधित अधिकार

कॉपीराइट 2016-2018 रेशेशे टेक एलएलपी. सारे अधिकार सुरक्षित है।

माइ स्कूल सर्वर, माइ स्कूल सर्वर लोगो रेशेशे टेक एलएलपी के ट्रेडमार्क है।




संपर्क करे
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कॉर्पोरेट मुख्यालय


रेशेशे टेक एलएलपी

501/बी सिनेरजी बिल्डिंग , एल-74 कॉर्पोरेट रोड, मकरबा, अहमदाबाद,

गुजरात 380015, भारत।

दूरभाष: +91-79-40080440

वेबसाइट: http://www.myscoolserver.com

http://www.myscoolserver.com/contact देखे क्षेत्रीय अथवा नवीनतम संपर्क संबंधी जानकारी हेतु।






सामाजिक


	ट्विटर

	https://www.twitter.com/myscoolserver



	फेसबूक

	https://www.facebook.com/myscoolserver



	गूगल+

	https://plus.google.com/+Myscoolserver













          

      

      

    

  

    
      
          
            
  
उपयोगकर्ता प्रबंधन


नया उपयोगकर्ता बनाएं

Admin-Desktop मे बूट करे और mssadmin से लॉगिन करके नीचे दिये चरण को पूरा करे –

जीयूआई द्वारा


	System → Administration → Users and Groups पे नेविगेट करे


	+Add बटन दबाकर नए उपयोगकर्ता को जोड़े और विगतों को भरे। (जब तक मौजूदा उपयोगकर्ताओ की सूची लोड नही हो जाती तब तक आपको प्रतीक्षा करनी पड सकती है।)


	नए उपयोगकर्ता का पासवर्ड आप अगले डायलोग मे सेट करे।




टर्मिनल द्वारा

sudo useradd -m <username>





पूछने पर  mssadmin's  का पासवर्ड डाले और आगे बढ़े।

उपयोगकर्ता के खाते को सक्रिय करने के लिए पासवर्ड सेट करें।

sudo passwd <username>






उपयोगकर्ता को epoptes समूह मे जोड़े।


Note

यह सिर्फ शिक्षको के  अकाउंट मे ही किया जाए क्योंकि इससे कुछ अधिक अधिकार प्राप्त होंगे।



Admin-Desktop मे बूट करे, mssadmin से लॉगिन करे और टर्मिनल मे निम्न का अनुसरण करे –

sudo usermod -a -G epoptes <username>





पूछने पर  mssadmin's  का पासवर्ड डाले और आगे बढ़े।






पासवर्ड को बदले


अपने खुद के पासवर्ड को बदलने के लिए

जीयूआई द्वारा

Alt+F2 -> ltsp-remoteapps users-admin





Password लेबल के सामने Change...  दबाये. इसके पश्चात Change User Password डायलोग मे जाकर अपना पासवर्ड सेट करे।

टर्मिनल द्वारा

Alt+F2 -> ltsp-remoteapps xterm -> passwd








दूसरे उपयोगकर्ता का पासवर्ड बदलने के लिए

Admin-Desktop मे बूट करे, mssadmin से लॉगिन करे और निम्न का अनुसरण करे -

जीयूआई द्वारा


	System → Administration → Users and Groups पे नेविगेट करे


	जिस उपयोगकर्ता का पासवर्ड बदलना हे उसे चुने


	Password लेबल के सामने Change... पे क्लिक करे


	पूछने पर mssadmin's का पासवर्ड डाले और प्रमाणित करे


	Change User Password डायलोग मे जाकर अपना पासवर्ड सेट करे




टर्मिनल द्वारा

sudo passwd <username>





पूछने पर  mssadmin's  का पासवर्ड डाले और आगे बढ़े।






बड़ी संख्या मे उपयोगकर्ताओ को जोड़ने हेतु

For adding  several users at one go, boot into Admin-Desktop, login as mssadmin* and perform these steps -


	स्पेस द्वारा अलग की हुई फाइल को बनाए जिसमे  ‘उपयोगकर्ता का नाम और पासवर्ड’ हो जैसे की sample।


चरण :


	LibreOffice Calc का प्रयोग कर फाइल बनाए


	Choose File -> Save as. You will see the Save as dialog.


	In the File type field select the format Text CSV (.csv).


	Enter a file name as users.csv and click Save.


	From the Export of text files dialog that appears, select the field delimeter as {space} for the data to be exported, and press OK.












Note

फ़ाइल में कोई खाली पंक्ति नहीं होनी चाहिए।




	टर्मिनल खोले और कमांड को निष्पादित करे –




sudo massuseradd <path_to_csv_file>





उदाहरण:

sudo massuseradd /home/mssadmin/users.csv








डिफ़ॉल्ट क्रेडेंशियल्स

डिफ़ॉल्ट रूप से, उपकरणो को पूर्व-कॉन्फ़िगर किए हुए निम्न उपयोगकर्ता खातों के साथ भेज दिया जाता है अर्थात यदि ऑर्डर देते समय कोई बदलाव नही मांगा गया है –








	खाता प्रकार

	उपयोगकर्ता का नाम

	पासवर्ड





	Admin

	mssadmin

	myskool



	Student

	student<n>

	12345



	Teacher

	teacher<n>

	imteacher







Warning

यह दृढ़ता से अनुशंसा की जाती है कि उपयोगकर्ता को पहली बार उपयोग करने पर खाता पासवर्ड बदलना चाहिए।









          

      

      

    

  

    
      
          
            
  
नेटवर्क कॉन्फ़िगरेशन


नेटवर्क मेनेजर द्वारा

MSS दो पूर्व-परिभाषित नेटवर्क कॉन्फ़िगरेशन के साथ आता है : स्टैटिक और डायनामिक।

यदि आपके नेटवर्क मे पहले से ही DHCP सर्वर है जो आपके लैन से जुड़े उपकरणो को आईपी एड्रेस प्रदान करता है फिर आपको MSS को डायनामिक मोड मे कोन्फ़िगर करना होगा। यदि ऐसा कोई DHCP सर्वर नहीं है तो MSS को स्टैटिक मोड मे कोन्फ़िगर करना होगा।

यह मान लेना उचित होगा के अधिकतर जगहो मे जहां एमएसएस इन्स्टाल करने के उद्देश्य से ही नया नेटवर्क सेटअप किया गया है,वहाँ पहले से कोई DHCP सर्वर मौजूद नहीं होगा, इसलिए सुरक्षित रूप से स्टेटिक मोड का विकल्प चुना जा सकता है।

यहाँ इसकी विगत दी हुई है के स्टैटिक अथवा डायनामिक विकल्प मे कैसे कॉन्फ़िगर करे:

लॉगिन करने के पश्चात, वह कनेकशन एडिट करे जिसका उपयोग नही होगा और “स्वचालित रूप से इस नेटवर्क से कनेक्ट करें जब यह उपलब्ध हैं” को अनचेक करे अवांछित मोड में स्वत: कनेक्शन के प्रयास को अक्षम करने के लिए. उदाहरण के लिए, यहाँ नीचे, हम डायनामिक को अक्षम करके और स्टैटिक को सक्रिय करते है।


[image: Network Manager - Edit Connections]


नेटवर्क मेनेजर – कनेक्शन का  संपादन


[image: Network Connections Window]


नेटवर्क कनेक्शंस


[image: Editing dynamic window]


डायनामिक मोड को बंद करने के लिए सही का निशान हटाएँ


[image: Editing static window]


स्टैटिक मोड पर स्विच करने के लिए चेक करें

अंततः, नेटवर्क मेनेजर मेनू मे “स्टैटिक” को चुने और अब आपका MSS स्टैटिक मोड मे कार्यरत है।







          

      

      

    

  

    
      
          
            
  
निगरानी और प्रसारण


Epoptes

Epoptes एक निगरानी और प्रसारण का साधन है जो पढ़ाने मे शिक्षको की सहायता करता है।

सिर्फ वही उपयोगकर्ता जो “epoptes” समूह से जुड़ा हुआ है epoptes की एप्प्लिकेशन का प्रक्षेपण कर सकता है. देखे उपयोगकर्ता को epoptes समूह मे जोड़े।।

पूर्व-कॉन्फ़िगर सारे शिक्षको के खाते पहले से ही Epoptes समूह के सदस्य है. epoptes का प्रयोग करना आत्म स्पष्ट और सहज ज्ञान युक्त है, हालांकि पूर्ण प्रलेखन यहाँ [https://translate.google.com/translate?u=http://ts.sch.gr/wiki/Linux/epoptes] उपलब्ध है।

English-Desktop का प्रयोग करते समय, शिक्षक नीचे दिये अनुसार Epoptes को शुरू कर सकता है :

Alt+F2 -> ltsp-remoteapps epoptes






Epoptes लॉन्चर बनाए

यहाँ दिये गए चरणो की मदद से शिक्षक डेस्कटॉप लॉन्चर  बना सकते है जिससे सिर्फ एक क्लिक से Epoptes को शुरू कर सके।


	डेस्कटॉप पे राइट क्लिक करे और लांचर बनाए... को चुने


	लांचर बनाए डाइलोग मे निम्न चरणो का पालन करे -


	नाम मे Epoptes दर्ज करे


	कमांड मे ltsp-remoteapps epoptes दर्ज करे


	ठीक दबाये









[image: Monitoring and Broadcasting - Epoptes Launcher]



Note

आपको डेस्कटॉप को  (F5) दबाकर रिफ्रेश करना होगा ताकि आपको नया बनाया हुआ लॉन्चर दिखे











          

      

      

    

  

    
      
          
            
  
सामग्री प्लेटफार्म


वेब सर्वर

माय स्कूल सर्वर उपयोग के लिए तुरंत तैयार वेब सर्वर के साथ पूर्व कॉन्फ़िगर किया हुआ आता है, जिससे आपको अपनी सामग्री को रखने और उसे स्थानीय नेटवर्क पर उपलब्ध कराने मे मदद मिलती है।

जो सामग्री आपने उपलब्ध कराई है वो किसी भी वेब ब्राउज़र पर उपलब्ध रहेगी उन सभी ग्राहको के लिए जो MSS द्वारा संचालित है निम्न लिंक पर -

http://server/






होस्टिंग कस्टम सामग्री

Admin-Desktop में बूट करें, mssadmin के रूप में लॉग इन करें और अपने कस्टम कंटेंट नीचे दिखाए गए स्थान पर रखें –

/var/www/html/mss/custom





कस्टम सामग्री टाइल के कस्टमइजेशन के लिए निर्देश ब्राउज़र के माध्यम से उपलब्ध हैं -

http://server/mss/custom






Note

सुनिश्चित करें कि सभी सामग्री को होस्ट करने के लिए निम्न न्यूनतम अनुमतियाँ होनी चाहिए - read और execute फ़ोल्डरों के लिए और फ़ाइलों के लिए read।



टर्मिनल के माध्यम से अपेक्षित अनुमतियों की स्थापना

अपेक्षित अनुमतियाँ सेट करने के लिए टर्मिनल में निम्न आदेश निष्पादित करें-

sudo find /var/www/html/mss/custom -type d -exec chmod a+rx {} \;
sudo find /var/www/html/mss/custom -type f -exec chmod a+r {} \;








व्यक्तिगत सामग्री होस्टिंग

प्रत्येक उपयोगकर्ता को अपनी HTML आधारित वेब सामग्री होस्ट करने की आवश्यकता हो सकती है. प्रत्येक उपयोगकर्ता अपनी व्यक्तिगत सामग्री को होस्ट कर सकता है -

/home/<username>/public_html





और इसके बाद सभी जुड़े ग्राहकों द्वारा इसे एक्सेस किया जा सकता है

http://server/~<username>






Note

सुनिश्चित करें कि सभी सामग्री को होस्ट करने के लिए निम्न न्यूनतम अनुमतियाँ होनी चाहिए - read और execute फ़ोल्डरों के लिए और फ़ाइलों के लिए read।











          

      

      

    

  

    
      
          
            
  
लिनक्स को घर ले जाए


लाइव यूएसबी बनाएं

Li-f-e: Linux for Education OS छवि सर्वर पर शामिल है और इसका उपयोग बूटेबल मीडिया बनाने मे किया जा सकता है Admin-Desktop मे बूट करके और फिर mssadmin उपयोगकर्ता द्वारा लॉगिन करे।


	ध्यान दें

	बूटेबल मीडिया को बनाते समय “isohybrid” / “EFI” विकल्प को चुने जिसका उद्देश्य उन कम्प्युटर को बूट करना है जो सिर्फ EFI बूटिंग का समर्थन करते है। इस विकल्प से आप लेगेसी हार्डवेयर पर भी बूट कर सकते है, तो इसका उपयोग तब करे जब आपको अपने हार्डवेयर क्षमताओं को लेकर निश्चिंता न हो।

बूटेबल यूएसबी बनाने के लिए " isohybrid" विकल्प का उपयोग आधिकारिक तौर पर सुजाया गया है, और इसलिए यह अधिक विश्वसनीय है। इस बात का ध्यान रखे के इससे यूएसबी डिवाइस पूरी तरह साफ हो जाएगा और विंडोज पीसी मे सामान्य स्टोरेज मीडिया के रूप में इस्तेमाल नहीं किया जा सकेगा।

“Ubuntu” / “Legacy” विकल्प का प्रयोग करे यदि आप चाहते है उपकरण को विंडोज पीसी मे सामान्य स्टोरेज मीडिया के रूप में इस्तेमाल करना चाहते है अथवा अपना डाटा संरक्षित रखना चाहते है। इस प्रक्रिया के लिए USB स्टिक पर एक vfat फोरमेटेड पारटिशन की आवश्यकता होगी। बूट मीडिया बनाते समय पारटिशन इस्तेमाल मे नहीं होना चाहये. यदि इस प्रक्रिया से बूटिंग नही हो पाती है तो isohybrid / EFI मोड का प्रयोग करे।






शॉर्टकट के माध्यम से

डेस्कटॉप पर से इनमे से किसी भी लोंचर आइकॉन का उपयोग करे - Live USB GUI EFI अथवा Live USB GUI Legacy आपके बूटेबल मीडिया के पसंद के आधार पर।




मेन्यू  के माध्यम से

System Tools -> Live USB GUI





इस प्रक्रिया मे आपसे ISO छवि मांगी जाएगी. Li-f-e.iso फाइल इनमे से किसी एक डायरेक्टरी पाथ पर उपलब्ध है - /recovery/ अथवा /home/mssadmin/।




टर्मिनल द्वारा

इस कार्य को एक से अधिक बार करने हेतु कमांड लाइन का प्रयोग करना ज्यादा सुविधाजनक रहेगा।

sudo live-grub-stick --isohybrid /recovery/Li-f-e.iso /dev/sdb








संदर्भ

नीचे दी हुई बाहरी लिंक्स देखे (इसके लिए इंटरनेट की आवश्यकता पड़ेगी) यह सीखने के लिए के यूएसबी स्टिक से कैसे बूट करे और समस्या का निवारण कैसे करे यदि यूएसबी बूट नही होती:

BIOS मे बूट ऑर्डर को बदले [https://www.lifewire.com/change-the-boot-order-in-bios-2624528]

यूएसबी डिवाइस से बूट करे [https://www.lifewire.com/how-to-boot-from-a-usb-device-2626091]









          

      

      

    

  

    
      
          
            
  
बैकअप और रिकवरी

हम समझते हैं कि दुर्घटनाएं होती हैं और हर किसी को दूसरा मौका मिलना चाहिए. ओपन सोर्स होने के नाते किसी को भी सर्वर के साथ खेलने का मन कर सकता है और ऐसा करने पर हम आपको दंडित नहे करेंगे। माय स्कूल सर्वर Factory Restore का विकल्प उपलब्ध करता है निम्न द्वारा –


	सर्वर बूट मेन्यू


	recovery.sh साधन द्वारा बनी USB से




फ़ैक्टरि रिस्टोर विकल्प सिस्टम को रिस्टोर करता है और उस स्थिति मे ले आता है जब वो रेशेशे के परिसर से बाहर निकला था, जिसमे पहले से किए बदलाव जैसे के उपयोगकर्ता अकाउंट आदि शामिल है, यदि डाटा ऑर्डर देते समय ही दिया गया था।


Warning

Factory Restore सुविधा का उपयोग करने से पहले सावधानी बरतें। यह सर्वर पर उपयोगकर्ता द्वारा किए गए किसी भी कस्टमाइज़ेशन को ओवरराइड करेगा और उसे फ़ैक्टरी शिपिंग स्थिति में पुनर्स्थापित करेगा। यह उपयोगकर्ता बनाया डेटा भी हटा सकते हैं। इसलिए, यदि उपयोगकर्ता द्वारा बनाया गया डेटा मूल्य का है, तो यह पुरजोर सिफारिश की जाती है कि /home डेटा का समय पर नीचे दिए गए चरणों का अनुसरण करके किसी बाहरी मीडिया पर बैकअप लिया जाता है।




Note

Factory Restore सुविधा किसी भी प्री-लोडेड या कस्टम लोड की गई वेब-सामग्री पुनर्स्थापित नहीं करती है। http://server के माध्यम से सुलभ सभी सामग्री का बैकअप और बहाली अंतिम-प्रयोक्ता की जिंमेदारी है। आसान और उपयोगी बैकअप चरणों के लिए नीचे पढ़ें।



कई स्नैपशॉट बनाए जा सकते हैं। यह रिकवरी पारटिशन पर उपलब्ध जगह पर मर्यादित है। MSS बोरग डीडुप्लिकेटेड बैकअप का उपयोग करता है इससे सिर्फ वही बदलाव जो आखरी बेकअप के बाद हुए है वही अगले बैकअप के वक्त संग्रहीत होते है।


	बैकअप बनाने के लिए, नीचे दिये कमांड को रूट के रूप मे चलाये (sudo su -):




recovery.sh create






	चालू सिस्टम मे से फ़ैक्टरी छवि को रीस्टोर करने के लिए, नीचे दिये कमांड को रूट के रूप मे चलाये (sudo su -):




recovery.sh restore [optional snapshot number]






	स्नैपशॉट संख्यात्मक हैं, 1 फ़ैक्टरी छवि को दर्शाता है. डिफ़ॉल्ट रूप से, रिस्टोर (पुनर्स्थापित)चलाने से  स्नैपशॉट पर पुनर्स्थापित होगा. आखरी लिए हुए स्नैपशॉट को रिस्टोर करने हेतु नीचे दिये कमांड को रूट के रूप मे चलाये (sudo su -):




recovery.sh restore last





स्नैपशॉट का प्रबंधन इस टूल और दस्तावेज़ के दायरे से परे है। अधिक जानकारी के लिए बोर्ग डॉक्युमेंटेशन [http://borgbackup.readthedocs.io/en/stable/usage.htm] को देखे.

यहाँ कुछ उदाहरण दिये गए है की borg की मदद से क्या किया जा सकता है:


	सारे स्नैपशॉटस की सूची बनाए:




sudo borg list /recovery/system






	कस्टम स्नैपशॉट बनाने के लिए, उदाहरण के लिए, /home का स्नैपशॉट बनाने के लिए:




borg init --encryption=none </backup/folder/path/home>

borg create --stats --progress --compression lz4 </backup/folder/path/home>::<snapshotname> /home






Note

/backup/folder/path/ मे पर्याप्त जगह होनी चाहिए।




	स्नैपशॉट से /home को रिस्टोर करने हेतु:




borg mount </backup/folder/path/home>::<snapshotname> /mnt

rsync -avP /mnt/* /home/





रिस्टोरेशन हो जाने पर:

umount /mnt






प्री-लोडेड सामग्री स्थान

अधिकांश प्रीलोडेड वेब सामग्री सामान्य स्थान पर होती है - /var/www/html/mss। हालांकि कुछ सामग्री जिनके पास अपना स्वयं का कस्टम स्थान है वह नीचे सूचीबद्ध हैं -


	NROER

	/home/docker



	Gyankunj Slate

	/home/mssadmin/slate



	ePathshala

	/home/mssadmin/.epathshala











          

      

      

    

  

    
      
          
            
  
समस्या निवारण


बूटिंग या फ्रीजिंग समस्या

यदि ग्राहक की मशीन बूट नही कर रही अथवा चलते समय फ्रीज़ हो जाती है, इसका कारण खराब नेटवर्क केबल, कनेक्शन अथवा स्विच हो सकता है। ग्राहक को सर्वर से सीधे जोड़ने की कोशिश करो लैन केबल की मदद से और ग्राहक को बूट करने का प्रयत्न करे। यदि ग्राहक बूट होता है, तो यह पुष्टि हो जाती है के ग्राहक और सर्वर दोनों काम कर रहे है। इसके बाद अपने भौतिक नेटवर्क के समस्या निवारण को जारी रखे या अपने नेटवर्क अभियंता से संपर्क करे।

यदि यह सारे चरणो का पालन करने के बाद भी ग्राहक की मशीन बूट नही होती है तो MSS सहायता टीम को संपर्क करे।




शीर्ष पैनल की अनुपलब्धत

यदि शीर्ष पैनल नही दिखती है तो निम्न का पालन करे –

Alt+F2 -> resetpanel








डेस्कटॉप को डिफ़ॉल्ट सेटिंग में पुनर्स्थापित करें

डेस्कटॉप को किसी उपयोगकर्ता की डिफ़ॉल्ट सेटिंग पर पुनर्स्थापित करने के लिए, इसे उपयोगकर्ता के लॉग आउट करने के बाद mssadmin अकाउंट से लॉगिन करे टर्मिनल में चलाये–

sudo mv /home/<username>/.config /home/<username>/.config-backup





इसके बाद उपयोगकर्ता को पुनः    लॉगिन करने के लिए कहे।

अथवा

उपयोगकर्ता चलते हुए सत्र मे यह भी प्रयास कर सकते है -

Alt+F2 -> resetdesktop





उपयोगकर्ता को बदलावो को लागू करने के लिए लॉग आउट करके फिर से लॉगिन करना होगा।




रिमोट डेस्कटॉप कनेक्शन संबंधी मुद्दे

mssadmin उपयोगकर्ता के रूप मे नीचे दिये गया चरणो का पालन करे (पूछने पर पासवर्ड दर्ज करे) -

सेवा की स्थिति की जांच करें

sudo systemctl status xrdp





सेवा को पुनरारंभ करें

sudo systemctl restart xrdp





XRDP प्रक्रियाओं का संचालन जाँचे

ps ax | grep xrdp





XRDP से संबंधित फाइलें लॉग करे

sudo tail -f /var/log/xrdp-sesman.log





rdp लॉगिन समस्या का निदान करने के लिए.

sudo tail -f /var/log/auth.log





उस उपयोगकर्ता के खाते से लॉगिन करे जो वर्तमान सत्र लॉगिन किया हुआ न हो।







          

      

      

    

  

    
      
          
            
  
दूरस्थ समर्थन

समर्थन टीम से दूर से समर्थन पाने के लिए, निम्न चरणों का पालन करें -


	किसी भी खाते से लॉगिन करे, Applications → Internet → Remmina पर नेविगेट करे


	नीचे दिये गए चरणों का पालन करें -






	ड्रॉपडाउन बॉक्स में RDP का चयन होना चाहिए |


	नीचे दिखाए अनुसार server टाइप करें |


	Connect ! को दबाये |





[image: Remote Support - Reminna]






	कनेक्शन की स्थापना के बाद, remmina स्क्रीन में mssadmin के रूप में लॉगिन करें |






Note

खुले हुए रीमेमीना विंडो में निम्नलिखित चरणों का पालन किया जाना चाहिए







	इंटरनेट कनैक्शन हेतु वाईफाई/ हॉटस्पॉट से कनेक्ट करें, वाई-फाई / हॉटस्पॉट कनेक्ट करें अनुभाग को देखे वाईफाई/ हॉटस्पॉट से इंटरनेट को जोड़ने के लिए |


	Epoptes को Applications → Internet → Epoptes से लॉन्च करे


	Help → Remote support मे जाकर Remote support को चुने






[image: Remote Support - Epoptes]






	remote-assistance संवाद में नीचे दिए गए चरणों का पालन करें -






	Method मे Graphic(VNC) चुना हुआ होना चाहिये |


	Host के प्रकार मे support.myscoolserver.com:5500 टाइप करे


	कनेक्ट करे को दबाये |





[image: Remote Support - Remote Assistance]






	सफल कनेक्शन होने पर, Status Connected में बदल जाएगी |





वाई-फाई / हॉटस्पॉट कनेक्ट करें

MSS में वाई-फाई / हॉटस्पॉट को जोड़ने के लिए, mssadmin के रूप में लॉगिन करें और इन चरणों का पालन करें -


	स्क्रीन के शीर्ष-दाएं कोने से [image: internet] पर क्लिक करें, और उस नेटवर्क के नाम पर क्लिक करें जिसे आप कनेक्ट करना चाहते हैं |






[image: Connect Wi-fi - Wi-fi List]



Note

यदि नेटवर्क का नाम सूची में नहीं है, अधिक संजाल का चयन करें ये देखने के लिए कि क्या नेटवर्क सूची मे नीचे है या नहीं। यदि आपको अभी भी नेटवर्क नहीं दिख रहा हैं, तो इसका अर्थ यह हो सकता है की आपका डिवाइस सीमा से बाहर है या नेटवर्क छिपा हुआ है।







	नीचे दिखाए गए अनुसार सत्यापित करे संवाद में mssadmin का पासवर्ड टाइप करें और सत्यापित किया दबाये |






[image: Connect Wi-fi - System Authentication]






	फिर से सत्यापित करे संवाद खुलेगा और पासवर्ड पूछा जाएगा , mssadmin का पासवर्ड टाइप करें और सत्यापित किया दबाये






[image: Connect Wi-fi - System Authentication]






	यदि नेटवर्क पासवर्ड से सुरक्षित    हे तो पूछने पर वाई फाई नेटवर्क प्रमाणीकरण आवश्यक संवाद मे पासवर्ड दर्ज कराये और कनेक्ट करे पर क्लिक करे |






[image: Connect Wi-fi - Wi-fi Authentication]






	नेटवर्क आइकॉन [image: wifi] इसमे बादल जाएगा






Note

यदि कनेशन सफल नही  होता है,आपसे फिरसे पासवर्ड पूछा जाएगा या ये आपसे कह सकता है के कनेक्शन डिस्कनेक्ट कर दिया गया है।












          

      

      

    

  

    
      
          
            
  
सपोर्ट और मार्गदर्शन


अक्सर पूछे जाने वाले प्रश्न

विभिन्न दृष्टिकोण से मिलते, एमएसएस उपयोगकर्ताओं द्वारा अक्सर पूछे जाने वाले प्रश्नों के उत्तर, यहां पाया जा सकता है -

http://myscoolserver.com/faqs




वीडियो और गाइड कैसे करें

यूट्यूब चैनल को मूल उपयोग प्रशिक्षण और नई फीचर वॉक-थ्रू ट्यूटोरियल्स के साथ नियमित रूप से अपडेट किया गया है. रुचि के क्षेत्र के लिए प्लेलिस्ट अनुभाग जांच करे -

https://www.youtube.com/myscoolserver




वारंटी सपोर्ट चैनल

प्रत्येक माय स्कूल सर्वर एक स्टिकर के साथ आता है जिसमे एक अद्वितीय MSS ID या S/N (क्रमांक) रहता है। यह आईडी रेशेशे टेक के साथ MSS हार्डवेयर से संबन्धित होने वाले सारे संवादो के लिए महत्वपूर्ण है। यदि आपको कभी भी MSS हार्डवेयर संबन्धित कोई समस्या आती है और यह वारंटी के तहत है, तो किसी भी सहायता केंद्र से टिकिट खोले और यह MSS आईडी और अपनी समस्या का विवरण लिखे।

सपोर्ट पोर्टल: https://helpdesk.myscoolserver.com

ईमेल-आईडी: helpdesk@myscoolserver.com

व्हाट्सएप दूरभाष: +91-79-40080440




महत्वपूर्ण लिंक

सेवा और सपोर्ट की शर्तें [https://www.myscoolserver.com/mss-service-terms/]

सीमित वारंटी शर्तें [https://www.myscoolserver.com/recherche-limited-product-warranty-mss/]






कम्युनिटी सपोर्ट


सीखने के साधन

माय स्कूल सर्वर हैकेट और बैंकवेल की कॉमिक पुस्तकों 1 और स्पोकन टूटोरियल 2 के कंटैंट के साथ आता है जो आपको उबुन्टु लिनक्स के बारे मे हर वो जानकारी प्राप्त करवाता है जिसकी आपको आवश्यकता है, अधिकतर सारी GUI एप्लीकेशन्स F1 हेल्प के साथ आती है, जिनसे संबन्धित दस्तावेज़ /usr/share/doc फोंल्डर मे उपलब्ध है।

कम्युनिटी निर्मित दस्तावेज उपलब्ध है:


https://ubuntu-manual.org

https://help.ubuntu.com

https://ubuntu-mate.github.io

https://help.ubuntu.com/community/CommonQuestions

https://help.ubuntu.com/community/Beginners/FAQ

http://askubuntu.com/questions?sort=faq

https://ubuntu-mate.community/t/ubuntu-beginners-guide-complete-how-to-install-and-run-first-update/955/7

https://ubuntu-mate.org/faq






उबुन्टु कम्युनिटी सेवा


http://community.ubuntu.com/help-information

https://ubuntu-mate.org/community






एमएसएस कम्युनिटी सेवा

https://github.com/RechercheTech/mss/issues




अपनी भाषा मे टाइप करने के लिए मदद

https://help.ubuntu.com/community/ibus




Li-f-e - Linux for Education सेवा

https://sourceforge.net/projects/cyberorg-home/support




कम्युनिटी सहायता मांगने से पहले पढ़ना चाहिए

http://www.catb.org/esr/faqs/smart-questions.html


	1

	http://hackettandbankwell.com



	2

	http://spoken-tutorial.org/about-us













          

      

      

    

  

    
      
          
            
  
संपर्क संबंधी जानकारी


[image: ]



कॉर्पोरेट मुख्यालय


रेशेशे टेक एलएलपी

501/बी सिनेरजी बिल्डिंग , एल-74 कॉर्पोरेट रोड, मकरबा, अहमदाबाद,

गुजरात 380015, भारत.

दूरभाष: +91-79-40080440

वेबसाइट: http://www.myscoolserver.com

http://www.myscoolserver.com/contact देखे क्षेत्रीय अथवा नवीनतम संपर्क संबंधी जानकारी हेतु।






सोशल मीडिया


	ट्विटर

	https://www.twitter.com/myscoolserver



	फेसबूक

	https://www.facebook.com/myscoolserver



	गूगल+

	https://plus.google.com/+Myscoolserver
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